Resco Explorer for Palm OS® v2.72 — User manual
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1 Introduction

Welcome to Resco Explorer for Palm OS® -
file manager, zipper, viewer, backup solution and launcher

Resco Explorer lets you organize and manage files and folders on your Palm Powered
handheld. You can perform basic managing tasks, such as creating, deleting, copying, or
moving files and folders.

Resco Explorer implements the complete file manipulation tools, selected launcher features,
zipper, fast image viewer and a lot of other tools. You get in one package handset of tools that
used to be scattered in various applications.
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Fig. 1 — Resco Explorer (two panel mode) Fig. 2 — Resco Explorer (single panel mode)
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1.1 Features

Explorer-like GUI that can work alternatively in one- or two-panel mode
Highly customizable: different layouts, columns, fonts etc.

Complete set of file/folder operations

Fully integrated zipper (content editable similarly to a folder)
Alternative ways for copying (drag&drop, cut&paste, Copy To)
Multi-selection

Incremental search

Search dialog with feed-to-listbox option

Advanced filtering

Text file processing

Internal image viewer

Application tree (Categories)

Control panel enabling to modify file associations, alarm definitions, etc.
Powerful preferences editor

File exchange using Infrared, Bluetooth or another available transport technology
Direct interfacing to many popular applications

Tools for DB analysis

1.2 Technical Specifications

Min. Palm OS version: 5.0 (Palm OS 4 version is downloadable from Resco web)
Supported resolutions: 160x160, 320x320, 320x480 portrait / landscape (DIA supported)
Other requirements (not mandatory):

= Resco Viewer works best with color devices and high-resolution screens.

= 500 KB of free RAM recommended.

Built-in image viewer: jpg/bmp/gif images and RAM images produced by Clie/Zire cameras;
possibility to use external viewer

Data files for these apps can be launched by a simple pen tap:
= Audio: mmPlayer, AeroPlayer, Pocket Tunes, TCPMP
= Video: mmPlayer, TCPMP, Kinoma Player (video)
= |mages: Resco Viewer, Splash Photo, Acidimage, GRX
= eBooks: iSilo, Wordsmith, TiBR, TealDoc, LionDoc, ReadThemAll, eReader

= Office documents:
0 MobiSystems OfficeSuite 7.25+
0 Repligo 2.1.4+
o PalmPDF 1.1+
o0 Documents To Go (v9: read/write access, older versions: only doc reading)

= Web/ html: WebPro 3+, Blazer 3+, NetFront (Clie), Novarra 3+, Plucker
= All applications using standard Exchange Manager protocol



Explorer relation to other apps

Application Remark

Backup programs (=) Explorer offers manual backup of mostly higher quality
(faster, less card space, verification tools) than single-
purpose backup apps — except Resco Backup, of course.

(-) Explorer does not support backup scheduling.

Launchers (+) Document launching
(-) Missing ability to create shortcuts for card apps
(+) Launching from zip archive

Cleanup, Removelt (=) Similar results of the static analysis (Explorer: Use
RAM context menu > Special Filters > Show Orphaned)

(-) No dynamic signature file
(-) No sandbox mode

Receiveit (=) Explorer receives any card file into the opened folder
provided no other app is registered for its extension.

(-) Explorer does not receive databases.

UnCache, DbCacheTool, (=) Explorer provides manual DbCache flush (RAM Info
OffFlush dialog)

(-) No auto-flush functionality included

PalmHandZipper, other zippers | (+) Explorer delivers much more

Other file managers (+) Explorer delivers more

Of course, that’s not all. We did not mention features such as image preview, mp3 replay,
editing of the txt files




1.3 Acknowledgments

Thanks to Alexander Pruss, author of NVVBackup who helped us with the implementation of
the DbCache flushing.

Zipper: Internally, Resco Explorer uses the ZLib 1.1.4, copyright (C) 1995-2002 Jean-loup
Gailly and Mark Adler. All rights reserved.

Jpeg: This software is based in part on the work of the Independent JPEG Group.

1.4 Installation, Upgrade, Uninstall

Installation (upgrade) is very simple:
Hotsync RescoExplorer.prc to the handheld. Delete of the previous version not needed.

To uninstall, delete the RescoExplorer from the handheld.

Further you may want to delete also created RAM zip files - use the standard system delete
dialog as well. (While Resco Explorer creatorld is 'IMGE', RAM zip archives use 'RExp’ -
hence they are not deleted with the Explorer.)

1.5 Registration

Resco Explorer for Palm OS® comes with a free 14-day trial. The trial is functionally
identical with the full version except it stops working after 14 days. You can get it working
again either by purchasing the unlock key or by installing a trial for an upgraded version.

Once you have purchased the product, you will receive the unlock code that will allow
unlimited use of the purchased version of the product. You will also be entitled to free
upgrades within one year from the date of the purchase.

After the one-year period elapses Resco will charge 50% of the product's actual price.



2 Basic skills

A lot of things are similar to the Resco Photo Viewer: tree, context menu, drag-drop, and
multi-selection. Plus a few techniques are added:

= Cut & paste,

= Intelligent toolbars (tooltips, files can be dragged onto the toolbar icons),

= Browse history (toolbar buttons back/forward), etc.

2.1 Basic concepts
Palm screen resolutions

Standard or LORES resolution = 160x160
HIRES resolution = 320x320 and higher
HIRES portrait = 320x480, landscape = 480x320

Palm expansion cards

There is a wide variety of expansion cards: MS, CF, MMS, etc. All these cards use to support
Palm standard — VFS (Virtual File System) — and hence they can be accessed by the Resco
Viewer or any other application relying on this standard.

What is important to realize is that the same cards can be used by the digital cameras, mobile
phones and other devices. If your handheld and camera have compatible card slots, you can
freely exchange the card between both devices.

Splitter

Movable line dividing explorer tree from the list. The splitter can be dragged (moved):
1. Tap the splitter and keep the pen pressed. (Note that the sensitive area is limited.)
2. While keeping the pen pressed move the splitter.
3. Move the pen up.

Resco Explorer remembers the splitter position and restores it after the restart.

Shift Indicator

Vertical arrow in the title-bar. The shift indicator works in a way similar to the shift indicator
on the desktop systems. It can have two states:
- Depressed (white) indicator is the standard state, where
= tap the file name/icon = view (depends on Menu Options > General )
= tap another column = select
- Pressed (red) indicator allows the Multi-selection

Long press of the shift indicator opens a context menu with various select options.

Incremental search

Start typing the searched name into the text box in the top right edit box. While typing, the
cursor moves to the first name that starts with the typed string.

Characters that would result in zero match are not accepted. (If there is no file starting with
X', this character will be refused.)

Incremental search works also for the folders. (In case of ambiguity files are preferred.)
To clear the search box press Bksp key (Treo) or wait a little while so that it clears itself.



Drive

A drive is simply RAM or a card. Palm handheld can have more cards, so more than two
drives are possible.

Folder
A folder can contain files or other subfolders. All folders are arranged into a hierarchical tree.

Folder tree

Hierarchical representation of the folders optionally displayed in the left part of the Resco
Explorer screen. The tree can have several roots (i.e. top-level nodes). Each tree node
represents a folder and can generally have other sub-nodes (sub-folders).

Toolbars

Both top and bottom toolbars have tool tips: Tap and hold to read the tool tip. To cancel move
the pen outside the toolbar.

Bottom toolbar can be hidden. (Options menu or the ‘triangle’ button.)
Several icons in the top toolbar react to a long press by showing a context menu.

Moreover, the bottom toolbar allows 2 ways to carry out selected action:
= Classical - by tapping the icon, or
= Drag selected file(s) on the toolbar icon.

File sorting

Current sort order is indicated by the blue triangle.
Tap the triangle to revert the file order. (But the folders are always listed first.)
Tap another column label to sort by that column.

Screen customization

Explorer screen can be customized in a number of ways:
= Show/hide the tree or the toolbar
= Use horizontal or vertical panel layout (General Options)
= Resize panels using the splitter
= Select columns (use main menu or long press of the column label)
= Resize columns by dragging the column border.
= Select icon- or report-view (icon at the bottom right)

Wildcards
Can be used in the search/filter dialogs.
. @ = Any text

= = One character

Examples:
= a*.jpg means all jpeg files starting with 'a’ or 'A’
= *gif means all gif files
= abc?? means 5-character names starting with abc (ABCxy, aBC12 etc.)



2.2 Context menu

The tree nodes, files in the right pane or some title bar icons have a context sensitive popup
menu. We use the term context sensitive because different objects offer different options.

To open the context menu touch the screen and hold the pen down until menu is displayed.
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Fig. 4 - Context menu for a file Fig. 5 - Context menu for a tree node (folder)

2.3 Multi-selection

Used to perform an action on several files at once (copy, drag, delete, send, pack).
To select several files use the edit menu or the shift indicator (vertical arrow in the title bar).
= Press the shift indicator.
= Use tap to select files.
= Perform the action (e.g. open the context menu or drag the selected files).
= Depress the shift indicator. (Although: Some users use multiselection the whole time.)

Notice that the multiselect mode differentiates between selection state and input focus
(cursor). There are more specifics for this mode:
= Folders cannot be selected with the center button as it is interpreted as "Open".
= Folder can be selected only with the pen.
= Some folders do not allow multiselection: Application categories, Control Panel

2.4 Cut&paste

Use to copy (Copy&Paste) or move (Cut&Paste) one or more files. Has the same effect as
drag.

To copy/move files:
1. Select one or more files you want to copy/move.
2. From the menu select Copy or Cut.
3. Select the target folder in the tree where you want to copy/move the item(s).
4. Select Paste from the menu.



2.5 Drag-drop

Drag allows copying/moving one or more selected files. It consists of three phases:
= File selection (Tap the file without moving the pen up)
= Filedrag (Move the pen to the selected folder)
= File drop (Move the pen up)

The tree auto-scrolls when dragging around its border and auto-opens the folders when the
drag cursor hovers over a folder node.

If Dropping dragged item confirmation is switched on, then before the drop a question
copy/move/cancel will be displayed. Otherwise this decision is taken:

= Move if the image was copied on the same drive (E.g. card -> card)

= Copy if the image was copied across the drives (E.g. card -> RAM)

Simple exercises to learn these techniques:

1. Drag any card item and without releasing the pen move it along the tree and its
borders (look for the position where the tree starts scrolling) and hover for a while on
selected tree nodes. (To open them.) Move up the pen in any position where stop icon
is shown. (This prevents any action.)

2. Make sure that the “Dropping dragged items” confirmation (Menu / Options /
Confirmations) is switched on and move various items from the list onto the tree. As
long as you always press “Cancel”, nothing happens.

2.6 Multiple drag
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Fig. 6 — Multiple drag

Behaves similarly to the single-drag except you copy several files at once. The process:
1. Press the shift indicator
2. Select files by tapping them
3. Drag them to the target folder
4. Drop

Multiple drag always displays this popup list during the drop:
= Copy - duplicates the dragged files in the target folder
= Move - performs first copy, then deletes the original files
= Cancel - aborts the drag operation



3 Main application screen
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Fig. 7 — Main application screen

Explorer works similarly to the standard Windows Explorer.
The main screen is divided into two parts:
= The tree (left pane),
= The file view (list; right pane) showing the contents of the currently selected folder.

The tree can be hidden:
= by dragging the dividing splitter, or
= Dby using the Menu > Options > Toggle Tree, or

= by tapping the Toggle Tree button *E:| in the toolbar.

The resulting single-panel system is fully functional, i.e. the use of the tree is optional and
matter of user preferences. (However, you cannot use e.g. drag-drop without the tree.)

General Options allow switching to the vertical layout, which might be an advantage on
HiRes+ screens.

Fonts can be customized for both explorer panels independently. (Font Options dialog)

3.1 Tree structure
The tree is displayed in the left pane of the Explorer.

The tree works in a standard way:
= By tapping the +/- icons next tree level opens or collapses. (The same effect can be
achieved by double tapping the node label.)
= By tapping a tree node files and folders (subfolders) stored in the corresponding folder
are shown in the right pane.
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3.2 Browsing

Left/right arrows shuffle the cursor between the tree and the file pane; up/down keys move the
cursor one position in the respective direction. Notice also “smart” use of the left key in the
tree: It jumps directly to the parent folder.

On the JogDial-equipped systems use the extra HW button (Back, Esc) to toggle the cursor
between the tree and the list. So one-handed control is possible with one exception: Older
handhelds equipped only with up/down keys cannot skip between the tree and the file pane.
Hence, these handhelds have to use the one-panel setup. (To achieve one-handed control.)

Things look differently on one-panel system (tree is hidden), but they are also easy to master.

3.3 Listview
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Fig. 8 — The list view with hidden tree

The right pane (list view, file view) displays list of files and (sub)folders that belong to the
selected tree node. Subfolders are listed first, then files.

Open the subfolder by tapping its name. (Notice that tapping the icon or another column
performs selection instead of the open action.)

The very first item ("..") represents the parent folder. (Exactly as on the desktop systems.)
This item is not used in the Applications folders. (Launcher view)

Variable list view lets you customize its contents and appearance:
= Use the Columns option dialog (or a long tap on the column label) to select columns.
= Resize columns by dragging column label borders (except the icon column).
= Tap column label to change the sort order. (Indicated by the blue triangle)

These settings are persistent, i.e. they are restored on the application start.

The other options influencing the explorer appearance are accessible from the General
Options dialog, e.g. vertical/horizontal explorer layout.

Memory indicator is shown in the upper left screen corner (in place of the application title)
when General Options / Show Memory Indicator is switched on. The indicator displays the
amount of the free space on the active drive (card or RAM). However, in case of several files
selected, it displays the count and the size of the selected files, e.g.“2/710k"* meaning "2 files
occupying 710 kB".
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4 Application menu

4.1 File menu
The File Menu offers:

Viewing selected files.

Basic operations such as creating a new folder, renaming, deleting, or duplicating.
Access to the file/folder properties.
Exchanging files via Infrared, Bluetooth, SMS, etc.

Operations related to the zip archives
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Fig. 9 — Menu File

4.2 Options menu

Fig. 10 - Menu Options

Options menu integrates basic mode-switching commands and various option dialogs.

General Options Dialog

Use as Default Launcher

Sets Explorer instead of the default Palm Launcher

Start in Fullscreen

Forces full screen disregarding the device status.

Show Memory Indicator

Shows memory info instead of the app title.

Vertical Layout

Toggles vertical/horizontal explorer layout.

Scrollbars on the left

Use with LeftHack. (Utility aiding the left-handers.)

Large Icons

Icon View is set using the button at the bottom-right

Tap on name = ‘Open’

Tap can be interpreted as Open or Select

Tap on icon = *Open’

Ditto

Center Button

Interpretation of the center button press; Long press is
not detected on Treo 600

Save Filter/Shift

Save title-bar button status across program runs?

External Tools dialog enables selection of the reader/viewer/player that will be used by
Explorer to open respective files. Option ‘None’ means that Explorer will rely on the

associations table.

Remaining Options Dialogs are self-explanatory.
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General Options o

™ Use as default launcher

O Startin Fullscreen (HiRes+)
' Show Memory Indicator
[ Vertical Layout

O Scrollbars on the left

[# Large Icons

# Tap on name ='Open’

[0 Taponicon="Open'
CenterButton|  Press = Open
Save [ Filter & Shift

([ OK )(Cancel )

Fig. 11 - General Options

Ask before:

[ Delete operation

™ Dropping dragged item

™ Clipboard operation (Paste)
O Launching app from Card/Zip

Confirm delete for:

[ Non-empty directory
[ Readonly file
™ System/hidden file

[ oK )(Cancel )

Fig. 13 — Confirmations

4.3 Tools menu

= You can use Backup to provide a safety copy of the RAM content, Restore to reverse

Reader: ¥ (none)

Viewer: ¥ Explorer

Player: |{none)
C1 Explorer

( OK )( Cancel )

Fig. 12 — External Tools
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Fig. 14 — Menu Tools

the backup or Verify to bytewise check the selected backup set.

You can Search for files.

Manage Associations dialog lets you backup, restore or repair the associations.
You can export files to the Memo pad or as a txt file.

RAM report displays the memory information. Includes a tool for flushing DbCache.
You can use Filter to determine which files are presented in the file view pane.



5 Working with Explorer

5.1 Control Panel

Control panel accommodates various system-wide settings.
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Fig. 15 — Control panel

5.1.1 Alarms panel

The panel lists existing alarms.
If you don't know about alarms, then make a small test:
= Run the Clock application and set the alarm to say 5 minutes of the current time.
= |f you wait those 5 minutes, you will see an alarm.
Alarm is simply a time instant when the Palm handheld is awoken and the control is given to
the application that set up the alarm.

Each application can have at most 1 alarm and can use it for its own purposes - maybe for a
user alert, maybe to do some background work.
Besides listing the alarms, the panel enables:

= The deletion of an alarm

= Re-scheduling of an alarm (tap on the date or time value). If you do so, the application

will be really called at a different time - even if it remembers the original time.

The last column - alarm launch code - is the value passed to the application and is listed here
just for interest.

Warning: While the alarm is really modified, the original application may not know about it.

Note also that while the application can have only one "Palm OS alarm", the user may be
presented with a series of alarms.
It is easy: 2 "user alarms™ for times t1 and t2 can be realized as:

= t1alarm,

= t2-t1 alarm set when the first alarm happens

14



5.1.2 Associations panel

This is a rather advanced topic and we describe here only the basics, while the more difficult
issues are left for a separate chapter.

In short, if the user has installed several applications that can process given data file (e.g.
viewers), Palm OS selects one of them based on associations. This is in fact the same scheme
as applied on the desktop systems.

Associations are used on many occasions, such as e.qg.:
= When receiving beamed data Palm OS has to decide which app will receive the data
= When previewing email attachment — same problem
= Explorer uses the associations when a data file is tapped. To prevent the confusion, 3
broad file categories (images, documents, audio) are treated via the External Tools
options. For the rest a decision based on associations is taken.

You can add, edit or delete an association. Please, be careful and do so only when you
understand the consequences.

Another feature that is dealt with in the Associations Panel is Hotsync directories.
Remember how many times you wanted to Hotsync some file and either did not know how to
do it or you could not find where the file was actually copied? The answer is the folder
specified via Associations Panel.

For example Resco Photo Viewer uses the directory /Palm/Programs/RescoViewer (a Palm
quasi standard) to store jpg, gif and bmp files.

Another viewer may decide for /DCIM (a standard obeyed by digital cameras) and both
viewers will then compete for the target folder definition. Probable scenario is that whenever
you launch one of them, the folder will be re-defined.

ivg o

Fil.. & Application HotSync Direct... Handlers:
Jpe  Pics&Yideos /DCIM/

html Web [mpics&videos
Jpeg Pics&Videos /Images/

il
Jfif  Pics&Videos /DCIM/ g
Pics&Videos /Images/ § ( Add ) (Delete ) (Default)

dprc  Applications

mid  Sounds

.midi  Sounds

.mpa Pics&VYideos /DCIM/
.mpg Pics&Videos /DCIM/

@ (CFO G J

HotSync path:
/Images/ _ |/DCIM/

|/AUDIO/
/PALM/Programs/

Fig. 16 — Associations panel Fig. 17 — Associations panel - edit
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5.1.3 Saved/Unsaved Preferences

Preferences play similar role as the Windows Registry.

SavedPreferences is a RAM database storing the preferences of individual applications. This
database is backed up during each HotSync and hence can be restored in case of a hard reset.

UnsavedPreferences is another RAM database containing app preferences, but their backup is
not performed — hence any reset will clear these preferences. Associations are actually part of
the unsaved preferences, but are handled by a separate control panel.

The preferences are modeled by a folder whose members are individual database records.

This access has a number of advantages over classical DB viewer (that was used in the

previous release), e.g. the records are sortable and the relation to the master application is

identifiable. Available user actions for preferences records are view and delete.

Another place, where you can access the application preferences is the applications tree.

Note that the Explorer keeps track of many so-called hidden CreatorID’s. This makes possible

to assign several prefs records to one of installed applications.

1G-28

“Device 1] Name A Ext
s+ Documents T

«+% Applications Applications [[nch @]  pref

=%ContralPanel | @ Bond Service lased.1]  pref

Calendar [PDat.1] pref

Unsaved Prefs Color Theme-colP [eal... pref

mR0M Date & Time [dttm,0]  pref

mRAMID) i Explorer [IMGE,0] pref

= m Builtin{ A:) i Explorer [IMGE.1] pref

+mPOSESIot1(B:) = Explerer [IMGE,2] pref

IrDA Library lirda 0]  pref

Messaging [HsChO]  pref

HiNotify [ascd0]  pref

MiiMatify [ased. 1] pref

MMNotify [ased.2] pref

MMNatity [ascd.3)] pref

LT T UL B P Ll a

O AT &)

Fig. 18 — Saved Preferences
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mR0M
mRAMID)

= Bualtin{:)

< m POSESlot1(B:)

Applications [lneh.1]  pref
Applizations [Inch.G5... pref
Applications [Inch 6%, pref
Bluetooth [BTMr 1] pref
CGalendar [PDat 68531] pref
Calendar [PDat 655331 pref
Calendar [PDat 655341 pref
Contacts [FAdd 65531] pref
Contaets [PAdd 65533] pref
Contacts [PAdd 65534] pref
Exglocal Library=locl .. pref

i Explorer [IMGE.1] pref
= Explorer IMGE.65533] pref
&7 Get BC [S70L.0] pref

Rl co TP BOCMAN  oood

w
1]
T

A

O PN LTI

Fig. 19 — Unsaved Preferences
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5.1.4 Notifications

A notification is an OS message sent to selected applications. To receive notifications, the
application has to issue an OS request and specify events are of interest. These requests
(called registrations) are listed in the Notifications panel.

Through the notification lists we can better understand the interactions between applications.
Notification analysis might help when we are looking for misbehaving application.

Palm OS is driven by events. Some of these events (e.g. pen press) are passed to the active
app. If a background application wants to react to these events, then it has register for
respective notifications. Note that under Palm OS 5+ the notifications present the only tool
enabling the activity of a background application.

The other events (reset, Hotsync etc.) cannot be sent to the active application, because no
application is launched during these events. Hence a notification is the only chance how an
application can e.g. initialize after a reset.

S i S S S i . S e S Ul

By Apps
L= Locked
P=Protected

b

RescoBackup, appl
sLateWakeup
=SyncFinish

RescoExplorer, appl, L

Fig. 20 - Notifications
Control Panel lists the notifications in two sort orders - sorted by application or by event.

Along with the notifications, Explorer shows the attributes — Locked and Protected. They are
important for background applications. An app that truly works on background (it processes

user events, i.e. receives "EventDequeued” notifications) must be both locked and protected.
Neglecting these rules can cause seemingly random crashes on the NVFS systems.

Notice that the Locked attribute is not well defined, because locking is done on the record
level. What needs to be locked is as a rule the "code 1" record as it usually contains the
callback code. Explorer DB viewer shows individual record locks in the record combo-box.

Applications receiving occasional notifications (e.g. reset, Hotsync...) usually need not be
locked, as these apps use as a rule safer (and less efficient) ways of notification processing.
(So-called launch codes.)

Remark:
Palm Internals (PI) is a freeware that lists more complete set of notifications, as it is able to
discover also so-called callback notifications:
- Pl output is difficult to read and PI can crash when constructing the list.
- If the user wants just the list of apps using the notifications, both programs use to give
similar or even identical results.
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5.2 Applications tree

- Device | [CT AN
# ClDocuments | amnamy T
: - Al Dir

+ % Control Pane| - fanes B
FvROM — Main Di
ESRAM(D:) = Multimedia i

+ @POSESIot1(A) ~ o™ 0

+ E4MBRAMDISK( — unfited Dir

- Utilities Dir

Fig. 21 - Applications
Applications node list Palm applications grouped by the traditional Palm categories.

You can find here each application with conveniently grouped resources:
= Application databases
= Application files located in the standard app directory /Palm/Programs/<AppName>
= Application preferences

Note that the listed resources are often richer than the resources familiar to traditional Palm
launchers. This is because Explorer keeps track of many hidden CreatorID’s.

Available actions:
= The files/databases can be managed in the same way as the contents of the RAM or
card folders.
= The preferences can be viewed or deleted.
= Applications can be moved between categories (use drag&drop or copy&paste).
= Applications can be deleted.

One-panel system

If you use one-panel system, then you can access application resources from the application
context menu, option Explore. For the other specifics of the one-panel system see the chapter
discussing app launching.
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5.3 RAM tree
RAM folder lists various databases residing in the Palm memory.

The Palm memory is structured linearly, i.e. it does not contain the folders. However, zip
archives are presented as RAM subfolders. More structured view of the RAM contents is
presented by the Applications tree.

There are altogether 7 columns that can be shown for each RAM database:
= Name

= CreatorID

= DbType (called here the extension)
= Size'

= Attributes

= |con

= Date

Use the column context menu (tap and hold the column label) or the Columns options dialog
to define the columns shown.

List of database operations:
= (*) database delete
= database rename
= (*) database duplication (appends "~" to the original name)
= (*) database copy (either via drag&drop, or copy&paste)
= (*) database move (either via drag&drop in the multi-selection mode, or cut&paste)
= (*) database info (allows changing database attributes except those that could cause a
crash)
= (*) database send (beam, bluetooth, Snappermail etc. - whatever installed)
= (*) pack (creates zip archive)
= view (opens hex viewer)
= open (opens the associated application — see the Associations Panel description)
= open with (let the user choose among applications able to handle given database type)

(*) The operation can be performed on several files at once. (Use multi-selection)

Zip archives

Zip archives are presented as RAM nodes (i.e. as folders) and you can really use them as
folders. For example it is possible to copy to/from a zip archive or preview zipped files.

! Size refers to the file size when the database is copied to the card. NVFS systems have also 'NVFS size*
column displaying the size in the flash RAM that is as a rule substantially higher. (Because all records are
rounded up to the multiples of 512 By.)

The computation of the NVFS size takes longer, therefore the column is switched off by default.

19



5.4 Card tree

There are many kinds of the storage cards (MS, SD, MMC...) and they all will be recognized
provided they support VFS (Virtual File System - standard since Palm 0S4.0). The same
cards can be used in other devices, e.g. PPC handhelds or Digital cameras. Interchanging the
cards between different devices is one of the methods of the data sharing.

The card is organized into the folders and files using FAT file system. (In fact, VFS interface
can be built on top of any other file system, but the currently available cards use FAT.)

Besides its simplicity FAT has several disadvantages, one of them being worse safety. FAT
corruption happens usually as a consequence of a crash during a write operation. Particularly
sensitive is the root folder: Avoid creation of files in this folder.

FAT corruption can often be removed if you mount the card as a Windows drive (via T5
Drive Mode or using various card readers etc.) and run old good chkdsk utility.

While you have the full control over the card, keep in mind that there are some rules, f.e.
= /Palm/Launcher is the place reserved for the system
= Subdirectories of /Palm/Programs are reserved for individual applications

Besides the classical cards, Resco Explorer displays also RAM disks and VVFS drives. Here
are some specifics of the Builtin drive:
= Itisallocated as part of the RAM on most models. It means f.e. that adding more
images to the BuiltIn drive decreases effectively the RAM space.
= PALM_DM folder mirrors RAM — it is where the databases are actually stored.

The card is presented as a root tree node and name of the form CardName(x:) where
= CardName is the card label
= "X"is dynamically assigned drive letter (Note that a card with different label will be
assigned different drive letter.)

File operations can be carried out in several ways. E.g. to perform a delete select one or more
files and do one of the following:

= Select 'Delete’ in the context menu

= Select 'Delete’ in the Application file menu

= Press delete icon in the bottom toolbar

= Drag selected file(s) onto the toolbar delete icon
(Notice that not all operations offer all enumerated alternatives.)

Here is a brief list of the card-related operations that can be performed with the Explorer:
= (%) file delete

file rename

(*) file duplication (appends "~" to the original name)

(*) file copy (either via drag&drop, or copy&paste)

(*) file move (either via drag&drop in the multi-selection mode, or cut&paste)

(*) file info (allows changing file/db attributes except those that could cause a crash)

(*) file send (beam, Bluetooth, Snappermail etc. - whatever installed)

(*) pack (creates zip archive)

view (opens hex viewer)

open (opens associated application - see Exchange Panel description)

open with (let the user choose among applications able to handle given file type)

(*) The operation can be performed on several files at once. (Use multi-selection, i.e. switch
on the shift indicator in the titlebar.)

20



List of directory operations:

directory delete (deep delete, i.e. incl. subdirectories)
directory copy (deep copy; use copy&paste interface)
directory creation

directory rename

directory pack (deep packing)

directory info (allows changing the attributes)

Zip archives are presented as card nodes (i.e. as folders) and you can really use them as
folders. For example it is possible to copy to/from a zip archive, preview zipped files or even
launch zipped applications.

Special operations:

Copy a data file between the card and RAM (the card file is stored as a DB stream)

Copy a RAM application to the card results in a .prc file, copy of a record database
produces a .pdb file.

Applications thus copied can be directly launched from the card. This Copy is a simpler
version of the "Install to Card" offered by several launchers - it does not care about the
additional data databases.

Never copy to the card apps that are registered as handlers of some data types (such as
viewers) or you risk corrupted preferences. (Discussed in the Associations chapter.)

Rename of the card root changes the card label.
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9.5

Started via menu (or context menu) View command.

Hex Viewer

By tapping top left corner you can select different modes (image, hex, text, database) - those,

which make sense, will work.

Database mode allows deletion of individual records. Specific feature of the database mode is

that BMP resources are displayed as images.
Binary editor is not implemented, editing of the text files is possible.

0000
0006
000C
0012
0018
001E
0024
002A
0030
0036
003C

FFDSFFET11399
457869660000
4D4D00 2R 00 00
0008 000RO1OF
0002 00000006
000000860110
00020000000A
o0o0O00BCO112
000300000001
00010000011A
000500000001

Fig. 22 — Hex Viewer

5.6

Text files are created using the "New" command. The file created will be 1 byte long

Text files

(containing just a blank character) so that it can be immediately processed in the built-in text
editor.

The text editor is able to edit just files up to 32KB. As a convenience you can select 2 font
sizes.

Remark:

.txt files can be processed also in the standard memopad. However, there is a substantial
difference: memopad does not edit the text file itself, but imports its contents as a new note.
(While the original text file remains intact.) This has historical reasons as in the older days

Palm did not support expansion cards and importing of the txt file into a RAM database was

the only possibility how to work with its content.
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5.7 Viewer

Edit ]

Text /T
Binary .B
Hex 7H
Image /I

Fig. 23 — Viewer

External Tools options dialog decides whether the internal or external viewer will be used.
Viewing of zipped images is possible, too.

Various ways to view an image:
= 'View' command (menu / context menu / toolbar) always uses the internal viewer
= 'Open' command uses the viewer specified in the External Tools options dialog
= 'Open With' command lets the user select among existing viewers

Internal viewer

A simple fast viewer providing full-screen image preview ("fit-to-screen” mode).
It is a part of the Hex viewer: By tapping the top left corner and switch to the hex view.
Supported images:

=  jpg/bmp/gif images on the Expansion Card (progressive jpeg unsupported)

= RAM images produced by Clie and Zire cameras

= jpg/bmp/gif images packaged as the RAM streams (produced e.g. by Resco Viewer)

External viewers
You can use Resco Viewer (efficient interface), alternatively any image viewer capable of

accepting images via standard exchange protocol (used e.g. by email programs).
However, this protocol is limited in respect to the image size.
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5.8 Zipper

The purpose of the zipper is to bind several data files (or RAM databases) together and to
compress and eventually encrypt them.

Explorer can pack/unpack a directory or one or more files. Directories are packed recursively,
i.e. the whole directory tree. Files can be either copied or moved to the archive.

Explorer treats the zip archives as folders and tries to do so in a transparent manner, i.e. you
can manipulate the packed files in the same manner as if they were in standard card folders.

When needed, the zip archives are unpacked on the fly. (This enables e.g. viewing of a packed
file or launching of a packed application without creating a temporary unpacked file.)

Archives can be created either on the card or in the RAM. (An interesting corollary: RAM
folders.)

Archive contents can be edited in a standard way: Files can be added (via drag or clipboard),
deleted etc. Operations are safe - in case of problem (e.g. low memory) a rollback occurs.

You can unpack zipped files in the same directory (choose menu option Extract here) or you
can enter the target path where you want to place the selected files (choose Extract...).

Path: a./My folder.zip

Compression: ¥ Normal (6)
Password: ag

( 0K ) ( Cancel ) & Move

Fig. 24 — Zip dialog

Compatibility

Compression itself is standardized, but there might be differences in the organization of
directories. The zipper is compatible with e.g. Total Commander (popular Windows utility)
zipper and several other popular zip programs were tested as well.

Compression quality

Which program can squeeze the data at most? We did some testing... Explorer Zipper
achieves good results in comparison to the existing popular Palm zippers.?

Another set of scarce tests indicated that the Windows Total Commander achieves better
results, but the difference is not too big. 3

One more remark: Do not compress what is already compressed — e.g. jpeg, gif, mp3... You
may achieve some savings but they will be very small. And at times it can happen that the
resulting zip will grow! (Because he has to add some headers to the compressed data.)

2 Random tests indicated that the Explorer achieves the highest compression ratios, but we did not test
systematically and therefore we cannot make any generalization.

® PC has larger memory allowing the use of a larger window; larger window means that the program can analyze
larger parts of the original file and also memorize more intermediate results.
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Zipper interface

Pack
The menu option is used to create a new archive out of (one or more) currently selected files.

Extract
Unpacks the complete archive into the selected directory. (Path selection dialog)

Extract here
Unpacks the complete archive into the current directory. (No path selection dialog)

Drag a file onto the zip archive
Adds the file to the archive.

Drag a file from the zip archive onto a folder
Extracts one file out of the archive.

Alternative handling
You can use Cut/Copy/Paste instead of drag.

Other editing possibilities inside an archive:
= create/delete folders,
= delete/copy/move files.

Encryption

Sensitive data files can be packed and encrypted. Viewing encrypted files requires knowledge
of the password that was used when the archive was created.

ZIP encryption is regarded by security experts as being unsecure. In praxis, your encryption
will be as safe as is your password.

If you care a lot about the safety, then use long complex passwords with mixed case. And if
your data are worth enough to engage professional code breaker for a long time, then find
another product offering AES encryption.

If you are interested in this topic you can e.g. Google for “zip encryption breaking” and get
thus the information about available code breakers. They typically use brute force attack, i.e.
enumerate password combinations trying to find the one that fits.
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5.9 Filter

Shown databases:

O System [ ovly

O a68k ¥ Others
Shown files:

OO0 Hidden [ Unix.DOT

M Name: *.jpg
[ Size: v atleast 50 KB

( OK ](Cancel ) ¥ UseFilter

Fig. 25 — Filter dialog

The filter dialog is accessible from the title bar (2nd button from the right ?) or via menu.

Filter determines which files are presented in the file view pane. Some of the settings are
applicable to the databases only (listed in the upper part), but there are also two settings that
relate to the files only. The name field allows the Wildcards.

Something for the Mac users or for those sharing the card with a Mac/Unix computer: Unix
Dot files are special configuration files that are "invisible™ to a normal list command. Their
name start with a dot and they are normally hidden.

In order to apply the filter, switch on the checkbox "Use filter". When the filter is active, its
icon in the title bar is red. While the filter settings are persistent across the program runs, the
“Use filter” value is saved only when the General Options specify so.

Select by filter dialog

It is very similar to the Filter dialog except it serves for Multi-selection - i.e. the files that
match the filter criteria are selected.

Special filters
RAM context menu allows for selection of special filters:

Show Orphaned DBs that are not recognized as owned by some app

Show Locked DBs with some record locked

Show Opened DBs opened by some app

Show Documents | DBs recognized as documents

Show Protected Protected DBs (special DB state when the delete requires more effort)
Show PIM DBs Contacts, Tasks etc.

This App Files All DBs belonging to the same app as the selected DB

Special filters can be cancelled using either the blue Back button (title bar) or the Backspace
key (Treo).
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5.10 Searching

26 items found (4 ]
v Name: *bmp @6

o Date: v before | 12/07/05.

blue_160x160.bmp
Ford Mustang2.bmp
green_160x160.bmp
red_160x160.bmp

Test16.bmp

( Start ) (Cancel ) [ Goto Ja

Fig. 26 — Search dialog
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+ #Applicati &2 ..Bmp/Lena bmp
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ESROM X .._160x160 bmp
EHIRAM(0:) B2 a://Bmp/rgb bmp
+ @mPOSESlo £ ..p/Skin24 bmp
& ..mp/Test1 bmp
01 ..est8_0S2 bmp
1 _.est8_0S2abmp

1 ../TestRGE bmp

(e c:p | (4 . tRGB_052 bmp 4
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Fig. 27 — Search results

Search dialog is accessible from the title bar (rightmost button @) or via menu.

If you don't know the exact name of the file you are seeking, use */? Wildcards.
(The */? buttons are visible only when the name checkbox is switched on.)

Found files are shown in the listhox.

You can either select one of the files and press 'Goto' button or press the '->' button.

In the latter case a new tree node (‘Search results’) will be created with all found files. The

node will be removed when the search button is pressed the next time.
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5.11 Tools for DB analysis

Explorer offers many tools starting from the RAM browser until the DB viewer/editor. In this
chapter we cover topics not mentioned elsewhere.

Hidden CreatorID’s

CreatorID is a value that defines the relation between the application file and other (mostly
data) databases. For example, if you delete an application from the Palm Launcher it will
delete the application itself and all databases sharing the same CreatorID.

However, many apps use secondary CreatorID's. Such databases look then as if they were
orphaned, i.e. not belonging to any application. We call such CreatorID's hidden.

Explorer traces many hidden CreatorID's. (Not all as there are simply too many of them; the
selection was based on application popularity.)

Application resources

Each application in the Applications tree has the Databases and Preferences subfolders - i.e.
unless they are empty. The folders display also databases/preferences with known hidden
creatorID's.

(If you use one-panel system: Go to say /Device/Applications/All/, select an application, open
its context menu and select Explore.)

Application icons

App icons are assigned based on various criteria (f.e. images receive default viewer icon), one
of them being the relation between hidden and main CreatorID. (Note: Some apps do not
define icons for all resolutions. Use default font size to see as many icons as possible.)

Special filters

If you open the context menu for any RAM database, you can select from a range of DB
filters. (See the chapter called Filter.) Notice that the special filters considers hidden
CreatorlD's.)

63222k A1 Alnmd - T dc00®  v&a[
~'Device ¢ |Open Ext - Device 4 8 Name 4 Ext
+ UIDocurr} [|Open With... |DAT4 +IDocumr ContactsD... DAT/4
+ SeApplicc § (| View DAT# E + & Applicc § ] H DatebookDBDAT# E
A Contrc}| |Info DﬁTﬁI F-&Contrc DefaultHel... DAT#
ROM LE|Copy READ ESROM | IEEFind_DB READ
BT i Copy To... mac M(O 0 h... Mg -E
+ @Builtint] . |Cut rsrc +-[@ Builtint H|Show Orphaned
= @POSES Send HsTr = @POSES H|Show Locked
+Bmp New... HsT3 +Bmp H|Show Opened
[+ DCIM Rename... DATC [+ DCIM % Ic|Show Documents
Images : |Delete DAT MU A ™ Show Protected
o 2200} || Pack... D#Tﬁ:i (i i) £ V| Show PIM DBs
OISR NP Special filter... PUIES] (D 7 6 2 [ [This App Files
Fig. 28 — Special Filter Fig. 29 — Special Filter - choice
DB Info dialog

contains extended information in the last tab (application this DB belongs to etc.)
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5.12 RAM Info
Has your device enough memory?

Well, there are plenty of tools. But if you are in Explorer, you can use RAM Info dialog. Here
is what you can read from those numbers:

® Free memory(K):

Dynamic: 288173072
MaxChunk 2669K

Storage: 63222/65374
MaxChunk 63222K

DbCache: 28726/29695
MaxChunk 16383K

( Ok ][ Flush DbCache ]

Fig. 30 - RAM Info Dialog

= The figure displays (exceptionally good) numbers from an emulator. First number
means free memory, second the total memory.

= Dynamic memory (also called heap) is used for temporary allocations. Values about
300K may signal potential problems — depending on what is the application doing.

= Storage refers to the program memory that contains your applications and other data
databases. Try to keep free space of at least 1 MB.

= DbCache is a special memory area serving for access to the storage databases. Low
DbCache means that a lot of data was read. Your PDA may be at times slower,
nothing more — theoretically...

= All above memory pools consist of chunks. Some are free, some are in use.
MaxChunk refers to the largest free chunk. Low value indicate memory fragmentation
and may cause problems when allocating larger contiguous blocks.

29



5.13 Info Dialog

[General [sttributes|Dates| DB ) Attributes DatesDB)

Name: RescoViewer

[0 Readonly [0 Hidden
Type: appl [0 Stream ¥ Backup
Creator: IMGY.........oree [0 OKlnstallNew [ Launchable
Size: 479k{490834b) [0 Reset After Ins. [0 Bundle
145 records O Copy Protect [0 ApplinfoDirty
Version: v2.41 [0 Recyclable
Nvfs Size: 534k(547328b) [0 Open [ Resource DB

[ oK )[Cuncal] [ OK }(Euncel]

Figure 31 Info Dialog Figure 32 Info Dialog

Info dialog displays the basic info items about the selected file. The content depends on the
file type and also whether you selected one or more files.

The info dialog has very broad use: collecting the file information, rename, association
definition, attribute changes etc.

Info dialog can be used for card files, databases, card folders, zipped files, for single- or
multi-selection.

Special cases are discussed bellow:

General Tab - Database
Creator determines the application owning this DB.

Type is additional attribute. The use is up to the application, but some values are standard —
such as ‘appl’ means an application.

Newer handhelds only: Nvfs size refers to the real size the DB takes in the NVFS storage.
Note that it is larger than the RAM size. On some handhelds this value is not accessible.

General tab can be used to rename the DB.

General Tab - File

Files allow specific use: The field Opens refers to the associated application. F.e. if are on a
file Imgl.jpg, you can select this way the default jpeg viewer.

Attributes — multiselection

The Ul is the same as commonly used in the desktop world:
= Grayed attribute means Do not change
= Otherwise the same attribute has to be applied to all selected files
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Database — Attributes

Most attribs are for technical use and some are so dangerous that are forbidden to change.

(Open, Resource DB)

Bold attribs are those the normal users might want to change occasionally.

Readonly Edit forbidden. (Ignored by Explorer.)
Note that this attrib has special meaning on Life Drive where it
denotes pre-installed databases.

Hidden DB should be hidden from view. Used e.g. for hidden apps that are
part of larger package — such apps are not shown in a launcher.

Stream File stream = special DB format that encapsulates actual data.

Backup The DB is subject of Hotsync

OK Install New The backup conduit can install a newer version of this database with a
different name if the current database is open.

Launchable Can be launched from launcher.

Reset After Ins.

The device must be reset after this database is installed.

Bundle

The DB is bundled with its application during a beam. (It is beamed
together with the app.)

Copy Protect

Prevents DB from being copied by methods such as beam

App Info Dirty

Applnfo block (= special DB data) has been modified since the last
sync

Recyclable

Deleted on close or upon a system reset.

Open

DB is open = in use by some app.

Resource DB

Basic distinction between resource and record databases.

Most attribs are for technical use and some are so dangerous that are forbidden to change.
(Open, Resource DB) Bold attribs are those the normal users might want to change

occasionally.
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6 Launcher
6.1 Launcher

Applications are launched as in any other launcher — by tapping the application name or icon.
(If the General Options / Tap on name is switched off, then you have to use the Open
command in the context menu.)

You can launch RAM applications as well as applications on the card or in a zip archive.
In the latter two cases the application is first copied to the RAM and later (after its
termination) deleted from the RAM.

Document launching (launching of an application by tapping on its document)
This involves answering a few questions:
- Which application should be launched? For the answer see the table below.

- How the parameters can be passed? There is no standard answer. Applications that
published launch API are started this way (efficient). Databases are generally started using
sysAppLaunchCmdOpenDB launch code (efficient, but not all apps support it). Finally,
the card files are mostly passed using exchange manager interface. (Less efficient and not
all apps support it; it is the same interface as used e.g. for beaming.)

This isn’t an ideal situation and troubles are to be expected. For some file types the interface
will work, for the others not.

File associations (selecting an app based on the file type) are defined in the Control Panel, f.e.
= *txt files can be handled (associated) with memopad
= *jpg files can be viewed by Resco Photo Viewer

Associations can be changed also from the File Info dialog - the "Opens" listbox. (Shown in
the General tab if there exists at least one application able to handle given file type.)

"Open with" context menu command overrides the existing association as it allows for
selecting the application that will be called. The selection is done among all applications that
declare themselves as able to handle particular file type.

RAM
.txt files Internal editor
tRAB databases RAM albums sent to RescoViewer
Foto, tJPG, .BMP, .GIF dbs | Viewer set in External Tools options
ToGo databases iSilo
Palm docs (TEXt databases) | Reader set in External Tools options
Other databases Application with the same Creatorld;
Data passed via sysAppLaunchCmdOpenDB
Special interface for Repligo, DocsToGo, MobiOffice databases
Card
.txt files Internal editor
mp3/ogg/wav files Player set in External Tools options;
if not set then the app set in Associations
jpa/gif/bmp files Viewer from External Tools; assoc. app otherwise
Other files the app set in Associations

Table 1 Application launching selected document
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6.2 Documents interface

The root folder “Documents” is intended as a place where users can access their documents,
images, eBooks etc. by a simple tap instead of using the extra step of launching the associated
application.

Documents folder behaves similarly to a card folder: You may add files, create subdirectories,
their sub-subdirectories etc. However, unlike the card folder, you add (copy, delete) links to
the source data file that resides on the card or in the RAM. (This, however presents a new
problem: If a file ceases to exist — is deleted or card removed — the link becomes invalid)

EEm=cor: 75 ] | MEEETTITTEEEN)
I Device B Name L RAM or Card databases
288 Documents e AR | B Documents [ eBooks
+ Ffpplications _J RAM Documents| [1 Images [ Music
+- % Control Pan 1 RAM Images !
#IROM 1 RAM Music
SIRAM(O:) ™ Card
| ®4MBRAMDIS Path: )
al
Fxct: Documents
txt;doc;ppt;xs;|Images i
rgopdf  |Music
4 ity i *(Any)
O T N30 D ET a3 E ] (0K ][ Cancel
Fig 33 — Documents Fig 34 - Document query

Every folder can optionally have an associated document query:

= The query can be accessed via the document info dialog. Use it to define the document
types associated with the folder.

= You can specify whether the folder will contain any RAM documents. Notice that
there are no additional options in this case. RAM documents are simply all RAM
databases that can be opened via known document readers or office packages.

= Alternatively, you can specify a card folder and a list of extensions, e.g. “xls;doc;ppt”.
(There are presets for most common cases, in order to make the setup less complex.)

= More generally you can specify any combination of RAM documents/images/music/
databases and a card folder/mask.

You can call the Refresh command (document folder context menu). Refresh will:

Add the links to the files satisfying the query (if a query is defined),

= Delete invalid links, i.e. links pointing to a non-existing file. Note that after a card
swap all links to the old card become invalid.

Despite we discussed folder query, you may use the document folders differently. For
example as Favorites folder integrating links to any object you wish.

Default document folders

When you run the Explorer for the first time, the default doc folders are created for the
common document types: Documents, images, music.

33




6.3 Associations

What is an association?

An association is a relation between a card file type and the application that will handle it.
A typical example is

.mp3 -> Pocket Tunes
meaning that the Pocket Tunes application will be used to play mp3 records.

Normally installed apps define their associations themselves. Using the control panel you can
redefine these associations or even add the new ones.

Associations are used on many occasions, such as e.qg.:
= When receiving beamed data
= When previewing email attachment

Explorer uses the associations when a data file is tapped. However, to prevent the confusion,
3 broad file categories (images, documents, audio) are treated via the External Tools options.

A short excursion into the theory:

Applications tell the OS which file types they want to handle. This is called the file type
registration. As a result the OS maintains a list of applications that are able to handle given
file type. (Such as e.qg. a list of jpeg viewers.)

Each registered application can ask the system to make it the default application and become
thus preferred when the system decides who will receive the given file.

Note that 2 kinds of the file types are listed:
= File extensions (jpg, mp3 etc.)
= Mime types (image/jpg etc.)

Mime type (short for "Multipurpose Internet Mail Extensions™) represents simply another
name for the data type that was originally designed for the web browsers. In case of conflict,
the OS prefers the mime type association prior to the classical file extension. (Palm OS will
use “image/jpeg” viewer rather than *“.jpg” viewer.)

The associations are stored in the unsaved preferences and are thus cleared after each reset.
Different applications use different paths to restore their registrations: Some do so when they
are started, the others during the reset or even at other occasions.

Pitfalls you should be aware of:

= Unattended registration changes.

= Apps installed onto the card should be used with care in an association. The reason:
the OS sees only RAM apps. (Therefore 3" party launchers use to offer “shortcuts”*.)

= To copy a new file type to the card you have to introduce an association for that file
type: Select e.g. Explorer as the handling application and define the Hotsync path.
Afterwards you should pass this information to the desktop by performing a Hotsync.

* Shortcut is a small placeholder application that stands in RAM instead or the card application. This lets the
Palm OS think that the application exists. Placeholders are created by the most 3rd party launchers (Zlauncher,
Xlauncher...), but not by the standard system launcher.
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Important

Palm OS has a bug related to the Exchange Manager associations.
It manifests as a fatal alert 'Preferences.c, Pref DB Open Error' whenever any application
(Resco Explorer, Snappermail etc.) tries to list available handlers.

The reason for the problem:
= The registered application does not exist.

How this problem happens:
= When a registered application is deleted in a non-standard way.
= When an app installed on the card is registered and no RAM shortcut exists for it.

How to solve the problem:
= Use Resco Explorer menu option Repair Associations.
= Use so-called shortcuts when installing applications on the card.

Manage Associations Dialog

Resco Explorer v2.60 introduced "Manage Associations™ dialog that replaced older
associations-related menu options “Backup/Restore Associations".

This dialog does 2 things:
= Acts as a backup, except it cares about the associations only
= Repairs the associations, i.e. clears all references to non-existing applications, that

otherwise use to cause device crashes. Unlike other applications that offer associations

repair (e.g. Butler, PrefDoctor) Explorer also gives the list of problematic

registrations, which enables the user to take respective action. (In most cases it is an

app that should not be installed on the card.)

'Restore on each Reset' checkbox in this dialog allows the automatic restore of associations
after each reset/Hotsync. These are the 2 typical events when associations use to be modified
either by OS or 3rd party applications. (Explorer tries to be the last application that modifies

the associations, but this in fact cannot be guaranteed.)

Associations (1 ]

[0 Restore oneach Reset
Last Backup: 10/31/06 13.56:48

[ OK }(Backup ](Restore]( Repair )

Fig. 35 — Manage Associations
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7 Backup
7.1 Backup

The purpose of the Backup is to provide a safety copy of the handheld content.

Explorer backs up the complete RAM contents with these exceptions:
= Cache files for several popular apps - these files are automatically re-created
=  WiFiGenie: opened databases and RAM drive data files

Explorer uses the zip format to backup the RAM content, whereby all small databases are
merged together (file __smll__.zip) and the remaining databases are stored 1-by-1.

Advantages:
= Speed: Merging of small files minimizes card access.
= Space: Merging of small files minimizes number of card blocks used.
= Standard zip format makes offline operation easy.

Explorer allows multiple updates and different users can update to the same card.
Explorer supports full or incremental update (fast).

All backup sets are stored as subdirectories under /Palm/BackupE folder. The folder name
describes the user name and the date, when the backup was performed. The backup content
can be browsed (or edited) using standard means.

0S4 users

You can use zip compression, but the speed will be very slow. Instead, you should use the
"Store™ compression (i.e. no compression), which is the default selection. The other backup
programs use the same procedure.

Comparison to other backup solutions:

= Concerning the speed Explorer counts to the fastest backup applications.

= Explorer achieves the best compression ratio (together with Resco Backup), but the
advantage is not that big.

= Explorer does not provide automatic backup operation (periodic, on HotSync etc.)

Backup procedure

Backup is started from the main menu. First screen allows these operations:

= Select/unselect files for backup using pen tap or context menu. The selection is
remembered and restored next time you open the backup dialog.

= Select visible columns (long tap on the table header).
= Select the sort order by tapping respective column label.

= Filter shown files by using the graphical filter button. (Notice filtering of the
locked/opened databases.)

= Attributes column displays 3 flags:

o0 B for databases that are hotsynced

O for opened databases (risky)

XO for exclusively opened databases (unreadable databases)
L for locked databases (less risky)

O OO
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Next screen allows these decisions:

= Drive where the backup will be stored. (Normally a card.)

= Select incremental update (the last backup will be modified to reflect the changes) or
new update (full backup).

= Select optional encryption. (Password checkbox; be aware that if you loose the
password, the backup cannot be accessed.)

= Select the compression level. The default (suggested) choices are fast compression for
ARM handhelds, no compression (Store) for OS4 handhelds.

Backup - Step 1/2 Backup -Step 2/2 i)

Select files: 93/93(7921k) Card: « POSESlot!

g nld - Last backup: 12/28/05 11:58.00

14ptBold.zip i Update? Update New

16ptBold.pdb

18ptBold.pdb : o )
18ptThin.pdb Name: X 28-12-05 11-58

3136902676 : Skip M OldPIMDBs [0 Readonly

5ii=|_iSiloDocSettingsDB_
B PrMe Info O Compute Crc

Bl Pride_MostRecent

B | AddressCitiesDB i Compression: w None {(0)
(Next>) (Cancel ] T (<Prev) [ Finish ) (Cancel )
Fig. 36 — First backup screen Fig. 37 — Second backup screen

After the backup is done, the report window shows the list of all files with the results:
= OK means the particular file was stored.
= ==denotes unchanged (skipped) files. (Incremental backup only.)
= Remaining rows are written in red and contain the error description. (Backup does not
stop on error.)

The list is sorted: 1. errors (they cannot be missed),
2. newly stored files,
3. skipped files.
The list can be exported as memo and the created backup set can be immediately verified.

Encryption

Explorer can optionally encrypt stored data. To do so you need to specify the password. If you
do so, then the Restore operation will be refused if the user types the wrong password.

Password is used whenever a new file is added to the backup set. This particularly means that
when you change the password while some backup set exists, next Update operation will
produce an invalid backup set because unchanged files will use the old password, while the
new files will be encrypted with the new password. Never change the password for an
existing backup set!

Explorer uses zip-based encryption. It is fast and the zip programs understand it. Concerning
the safety this encryption can be broken, but it is not that easy. (See the chapter 5.8 Zipper)
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7.2 Restore
This is the reverse of the backup - it allows the restoration of the databases from a backup set.

Restore of some files may be problematic. Usually they are the opened databases, some of
which may prevent any access at all — those that are opened with exclusive access. Be careful
with these files. They are often opened by various hacks or as a reaction to reset etc.

Safest restore conditions are created by the warm reset. Warm reset prevents automatic
launching of hacks etc. and minimizes thus the number of opened files.

First restore screen allows selection among existing backup sets. Normally only the sets
made by the current user are offered, but after a hard reset (when the user information is lost)
all backup sets are listed.

Use the Delete button to remove unneeded backup set.

Restore-Step1/2 © Restore-Step2/2 ©
Choose backup: N - B

Name Date?
® 23-10-06 14-54 10/23/06

Bluetooth Trusted Dev...

ReseoPrefBackup.pre
Saved Preferences.pre
SerShotDB.pdb
Unsaved Preferences....
VpadDB.pdb

( Delete | [ Next > ] ( Cancel )

(<Prev)( Finish ) (Cancel ] T

Fig. 39 —Second restore screen
Fig. 38 — First restore screen

Second restore screen evaluates the differences and allows to select files for restore:
= [RAM] button shows files that are in the RAM, but not in the selected backup. (These
files are left unchanged.)
= [Card] button presents files in the selected backup; you can use these filter buttons:
e >>shows RAM files that are newer than their backup counterparts. (l.e. they
were accessed since the last backup.)
e << shows backup files that are newer than their RAM counterparts (or when
the RAM file is missing).
e I=shows files that differ in size.
e ==shows files with the same size and date. These files are by default excluded
from the backup, but you are free to take another decision. (Imagine a file that
is updated without changing its size and date. Strange, but possible.)

You can use similar actions as for the backup:
= Select/unselect the files via pen tap or via context menu.
= Use custom filtering. (Filter button at the bottom.)
= Define columns displayed and the sort order used.

Pressing [Finish] button starts the actual restore operation on the selected files.
Final report has similar properties as the backup report - i.e. the special sorting and export to
memopad.
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7.3 Verify

Verify backup menu option enables reliable check of the selected backup. This function
replaces to a large extent the backup set testing.

The function performs bytewise comparison of every backup-ed database to the original RAM
database and is thus a tool to
a) Find the differences between the actual RAM databases and their counterparts in the
backup set.
b) Localize the backup bugs. (This argument applies primarily to the NVFS systems).

Backup verification can be launched either from backup (immediate verification of the
created backup set) or independently. In the latter case the interface is very similar to the
Restore: First the backup set selection, then the verification.

The report window resembles the Restore report as well. There is just one addition: It allows
for the removal of individual backup files.

As already stated, Verify dialog uses the most reliable comparison method — bytewise data
comparison. Update Backup procedure seeks for the differences as well. However, the
comparison criteria used are different - the database size and the modification date. This
comparison cannot detect e.g. bugs caused by the NVFS problems.

Note that a reported difference does not need to mean a problem - even if you perform the
verification immediately after the backup. E.g. preferences or various caches may change
virtually at any time.
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8 NVFS devices

The new feature used on all modern Palm devices is NVFS - Non-Volatile File Storage.
NVFS basic advantage (and reason of being) is that it preserves the data also after the total
power discharge.

NVFS databases can't be accessed directly. Therefore Palm OS reserves part of RAM called
DbCache. Prior to its use the databases are copied from NVFS to the DbCache and after the
use they are copied back (if changed) or just purged (otherwise).

DbCache gets subsequently filled because the databases are not immediately purged, but (for
performance reasons) stay in the cache as long as there is enough space.

On T5 the DbCache has 10 MB and it is considered full when the free space reaches approx.
1MB. Later Palm OS versions allow DbCache to decrease to nearly zero. Full DbCache
means slower data operations because of the increased data exchange between the NVFS and
the DbCache. DbCache can be emptied only via reset.

NVFS has different granularity than the conventional RAM with the lowest accessible unit
being between 32-512 By depending on the handheld type. Consequently the databases with
small records (e.g. contacts) will occupy more space on NVFS than in the older RAM-based
systems. This was a serious problem in earlier releases that used 512 By NVFS record size.

NVFS Bugs

It is known fact that the NVFS implementation is not reliable. As a rule, the problems
manifest when the DbCache is full.

The situation is improving with every new Palm OS version. First models were very buggy
and our stress tests indicated that certain DB services fail in 0.1% cases when the DbCache is
full. There exist workarounds for most of the cases - unfortunately not for all. (E.g. when
Palm OS itself uses these services.)

NVFS-aware applications

Programming under NVFS is different. While it does not matter that much for conventional
application, it has a large impact on background apps that must cope with the fact that the DB
data are not static by default.

Background apps that are not NVFS-aware work as a rule reliably until more intensive data
operations are performed on the full DbCache. The peculiar thing is that the user will see
crashing the application running in the foreground. Typical examples are mysterious HotSync
crashes or crashes of the backup programs.

If you experience such crashes, then prior to drawing any conclusion perform warm reset test.
(Reset while the Up key is being pressed.) Special on this reset is that it does not send any
notifications that are otherwise used to start running the background applications. If the
crashes disappear after warm reset, then the problem is in the background applications.

Our tests revealed these dangerous background applications
= ClipPRO2.1.1
=  TextPlus 5.6
= Okey1.2.3
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9 Remarks

ZL auncher

ZLauncher Users should make sure that they have used the ZLauncher option to overwrite the

Palm Categories with the ZLauncher Categories. Otherwise Resco Explorer will show the
original Palm Categories.

Tungsten T3

If the fullscreen is not properly working, check please whether you have installed Palm OS
patch from PalmOne.

Clie
Back key toggles between the tree and the list
Support for Clie CF cards

Clie CF cards (concerns NX60, NX70V, NX73V, NX80V, NZ90) do not support standard
VFES (Virtual File System) interface and as such are invisible to standard Palm apps.
However, you can use CF Enabler from Athena America (former eruware) to pass past this
limitation.

Clie Camera RAM images
To convert those images to standard jpeg format drag them onto the card.

Zire
To convert Zire Camera RAM images to standard jpeg format drag them onto the card.

iQue 3600
ESC key toggles between the tree and the list
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10 Tips

Tips to reclaim more RAM space

Store camera images on the card.

BuiltIn drive is actually allocated in RAM. It growths (and the RAM shrinks) with
each file added. Do not use it to store data that can reside on the card.

Simple apps that do not depend on Palm OS messages (notifications, alarms, reset
initialization...) can be copied to the card.

Such apps can be even zipped in RAM and launched directly from the zip archive

Delete orphaned files from the RAM. As a guidance use RAM context menu of any
DB > Special Filter > Show Orphaned

Consider using Uninstall Manager that claims to clean orphaned files automatically

Setup apps that use RAM cache to clean the cache on exit. Can be done for example
for Blazer or Resco Photo Viewer.

Card tips

Do not place files into the root folder as it is the most sensitive folder as far the
corruption is concerned. The root should contain only subfolders.

Card corruption is as a rule a consequence of a crash during a write operation.

FAT corruption can often be removed if you mount the card as a Windows drive (via
T5 Drive Mode or using various card readers etc.) and run old good chkdsk utility.

Easy test when you suspect card problems: Test the card in several programs
(Explorer, FileZ). Not a proof, but sometimes helps.

Never copy to the card apps that are registered as handlers of some data types (such as
viewers) - unless you use launcher able to create so-called shortcuts.

How to fix a reset loop

Try warm reset (reset while holding Up key). This helps in some frequent cases:

Crash happens in the initialization of some app: In this case Palm launcher works. As
next find the misbehaving application:

o If you have notification lists produced by Explorer or Palm Internals under normal
conditions (warm reset clears the list), then look for ResetFinished notification.

o If you do backups via Explorer or Resco Backup and have known good backup set,
you have enough tools to analyze the changes. E.g. Explorer Verify or Restore.

o Or use standard actions: remove last installed apps as the most probable candidates
or disable selectively background applications.

Launcher DB is corrupted: Palm launcher does not work. If you manage to start some
file manager, delete RAM database psyslaunchdb. (Will be re-created after reset.)

Preferences are corrupted: Use Explorer to delete Saved and Unsaved Preferences
(RAM databases.) Alternatively delete just preferences of selected applications. (Can
be done from the Control Panel.)
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How to start Explorer during a reset loop (Treo 650)

Warm reset

Start Phone application

Menu > Edit Favorites Pages: Assign Explorer to a free entry
Press Down arrow to open Favorites

Start Explorer

If you have another handheld, you might be able to find a similar sequence.

How to analyze a random crash

Again, warm reset is the key. If the crashes disappear, the reason will be in some
background application. If the crashes continue, it should be the active application.

How to look for misbehaving background app

Background apps can communicate only via notifications — let’s start there. You can
use either Explorer Control Panel or Palm Internals (richer content, more difficult to
read.)

Google for the software compatibility lists, for example for “T5 compatibility list” and
check which apps are listed as dangerous.

Or use standard actions: remove last installed apps as the most probable candidates or
disable selectively background applications.

You need a test scenario. For example NVFS-related bugs use to happen under stress
conditions when the DbCache is full. A good simulation tool is the Verify Backup
procedure in either Explorer or Resco Backup: It fills the DbCache very fast and does
not write to the card.

Other common crash reasons

Low memory: Some apps or even Palm OS itself may not handle low memory states
correctly. To be on the safe side you should have at least 1 MB of the free program
memory.

Card corruption: If the crash is related to the card write, you should check the card.
(See Card Tips)

Suspecting PIM data? Use the free dbScan utility to check your datebook.

How to understand palm errors

Errors such as “Emul 68kMain.c, Line:403...” can be decoded only by Palm developers who
have access to the newest OS source code.

Classic Palm error codes (e.g. 2a02) can be decoded at http://prc-
tools.sourceforge.net/errorcodes.htmi

Treo: You can get additional info by reading HsTraceDatabase. Just “View” it in the
Explorer and walk through the records. (Dialing #*377 on the Treo GSM version
reads just this database.)
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Sending a .txt file

Problem uses to be on the receiver side as .txt files are intercepted by default as a memo.
Solution: Control Panel > Associations > Edit .txt association > Select Explorer

Note: To preserve this change across reset, read the next paragraph.

Receiving any card file

Card files are received into associated apps (Control Panel > Associations). However, if you
are getting the error “Data received in unknown format”, then simply open the Explorer and
select the folder where you want to receive. Easier than playing with associations, isn’t it?

Preserving associations during reset

Example: If you defined .txt association as described above, next reset will restore Memopad

as the handler for text files.

Solution: Main menu > Tools > Manage Associations: Select ‘Restore on each Reset’ and
then ‘Backup’
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